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Dear Marketing Executive,

It’s 6:00pm. You have one item on your
To-Do list crossed off, and the other ten
haven’t been touched. Just then, “you-
know-who” pops into your office wearing
that slightly manic grin that you have
come to know is a very, very bad sign.

“Guess what!” he exclaims. “I promised a
client we’d run a sponsorship ad. It was
due last week, but I got an extension so
we have until tomorrow!”

You glance around your office and,
indeed, he is definitely talking to you.

“How,” you ponder, “did I become the
D.G.D. (Designated Graphic Designer)?”
Maybe it was when you mentioned, in
passing, that you retouched your wedding
pictures in Photoshop. Or that once, at
a former job, you sat next to someone
who used PageMaker. Or perhaps it was
simply due to the fact that you inherited
the only computer in the company that
has a few graphics applications loaded
onto the hard drive.

Whatever the reason and despite the fact
that you never took a single class at
MassArt or remotely enjoyed finger
painting as a child, you find yourself
launching QuarkXPress and wondering
if the color palette should be set for
Spot, CMYK, or RGB.

At Clockwork, we’d love to help you
through these situations, but realize
that’s not always feasible or practical.
So, in an effort to support our marketing
clients and cohorts, we bring you…
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Q: How do I decide which
application to use when I
start a new project?

A: To answer that question, let’s discuss
the major graphics applications available,
and define what each is really good at
doing:

QuarkXPress by Quark, InDesign by
Adobe, and PageMaker by Adobe are
all page layout applications. So if you
are starting a project that involves the
design and layout of a page with text,
photos, and maybe a logo (such as for
an ad), you most likely will want to use
one of these three applications. If you
are embarking on a multipage project
like a brochure, datasheet, booklet, etc.,
then you will definitely want to use one
of these three applications.

If you have never used and are consider-
ing purchasing one of these three
programs and don’t know which to get,
designers do have their personal favorite.
Note that InDesign and PageMaker are
competing applications, both owned by
Adobe. This is the result of Adobe buying
out the former owner of PageMaker
(a company called Macromedia).
PageMaker is a much older, “clunkier”
application (in our humble opinion) that
we think Adobe may eventually phase out.
Here at Clockwork, we are QuarkXPress
fans. We’ll leave it at that for fear of
being chased down by Adobe salespeople
(but feel free to call us and we’ll be
happy to climb up on our very nicely
designed soapbox and tell you more).
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As far as difficulty level, all three of these
applications are about the same. None
are “easy” in the sense that you should
not expect to open the box and start
using them in a day or two. To really
master one of these applications, you’ll
need to use them heavily for several
weeks, and probably want to take a full-
day class or two.

Illustrator and FreeHand by Adobe are
both drawing applications. So, if you need
to create an illustration, you’d need to
use one of these two options. Illustrations
can be very complex, such as this:

Or very simple, such as our logo:

If you need to create a really pretty chart
or graph (like the one on the next
page), you will also want to use one of
these two drawing programs.
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If you’re debating between using
Illustrator or FreeHand and wonder
why Adobe sold both, FreeHand was
formerly owned by Macromedia, and has
been phased out by Adobe, although it
does have some very nice features.

Photoshop by Adobe is a program
that’s used for editing and manipulating
photographs. For example, if your
webmaster wants to put your headshot
on the company website, you can use
Photoshop to magically remove those
dark circles under your eyes.

Photoshop is also used for many, many
other things. It’s a highly robust application
that has a very high learning curve (so
don’t expect to pick it up in a few days,
weeks, or even months, for that matter).

Finally, a word about Word by Microsoft.
It’s called Word for a reason, and the name
says it all: it’s an application that’s meant
for words. That’s text, to be exact. So if
you are writing a proposal, drafting a
cover letter, revising your resume, or even
starting that novel that will eventually
make you famous and allow you to retire
to a tropical island, fire up Word on
your laptop and start typing.
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On the other hand, if you need to lay
out something pretty like an ad,
brochure, or newsletter, we beg you,
please, don’t use Word.

Think of it this way: if Bob from
Accounting comes into your office and
says he needs a really nice “slide” presen-
tation created in full color, with lots of
pretty charts and graphs, you’d say “You
got it, Bob!” But if he then adds that he
needs it created in Excel because he
doesn’t know how to use PowerPoint,
you’d reply “Sorry Bob, that’s just silly.
Go back to Accounting” (or something
more politically correct, because you are
a true professional). How would Bob
feel if you asked him to manage all the
Accounts Payables and Receivables, but
use PowerPoint exclusively? He’d laugh
at you, and rightly so.

That’s how graphic designers feel when
we’re asked to design something in
Word. Yes, it’s possible, but so is drawing
a masterpiece on an Etch-A-Sketch:

(For more Etch-A-Sketch artwork by George
Vlosich, visit http://www.gvetchedintime.com)
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Q: What are the differences
between process, spot, and
RGB colors, and when
should I use each?

A: Process colors are known as CMYK
colors or 4C (four color). Spot colors
are usually defined by the Pantone
library, or Pantone Matching System
(yes, that’s PMS for short). RGB colors
are used for on-screen viewing, and
stand for Red Green Blue.

Process colors are the four printing
colors used in the majority of full-color
pieces. The inks used in four-color print-
ing are cyan, magenta, yellow, and black,
or CMYK.

(“K” is used for “black” to avoid the con-
fusion that “B” represents “blue”). By
combining varied amounts of these four
inks, a wide range of colors can be simu-
lated. If you look at a 4C printed piece
with a magnifying glass, you can actually
see the individual dots of color. To create
green, for example, dots of cyan and yel-
low would be used. At normal viewing dis-
tance, the dots merge together and the
eye sees green. All full-color photographs
require 4C process colors when printing.
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Spot colors are solid inks (like cans of
paint that you’d use to paint your
house), not a simulation made of other
colored dots. Spot color printing is used
primarily for matching a color exactly,
such as a company logo on stationery.

A spot color is often chosen along with
black (although sometimes with a second
spot color) and the result is a two-color
(2C) print run. Two-color printing tends
to be less expensive than four-color
printing, but not always (digital presses
can not use Pantone inks, and low-
volume print runs are cheaper on digital
presses). Other reasons a spot color may
be used are when a page has heavy
coverage of a single color, or when
colors are required that fall outside
the spectrum that CMYK can reproduce
accurately. Specialty inks such as
metallics and day-glow fluorescents also
require spot colors. The ’70s were good
for the spot color industry.

RGB colors, like CMYK colors, are made
up of tiny dots that when viewed at a nor-
mal distance simulate a wide spectrum of
colors. However, RGB colors are made of
red, green, and blue. A computer monitor
or a digital camera both use RGB dots to
simulate the colors we see every day with
the human eye. Except for low-cost office
color printers, RGB is usually avoided
when printing. Photos and graphics
specifically for websites and PowerPoint
presentations (viewed on-screen only)
should be created in RGB colors.
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Q: What’s the difference
between a raster and vector
image?

A: Raster, or bitmap images, are made
up of dots (color, black and white, or
grayscale). Vector images are mathemati-
cal descriptions of objects and their
properties, including shape, size,
position, and color.

Because raster images are made of dots,
they can’t be enlarged or “scaled up”
indefinitely. If you enlarge a raster image
in, say, Photoshop, it will try to create data
(i.e., more dots) to fill an area based on
the pixels closest to it, and eventually it
just doesn’t look right. In other words,
the image’s “resolution” is too low for
printing purposes. This is why a photo
that’s been blown up too much becomes
“fuzzy” or “pixilated”—the computer
inserts data based on surrounding dots
and does a pretty poor job at it. Raster
images include TIFFs and JPEGs.

Vector images, however, don’t suffer this
limitation. Because vectors aren’t images
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in the normal sense, but are instead the
mathematical properties of lines, curves,
and color fills, they can be scaled up to
any size whatsoever. A smooth circle is
still a smooth circle at a million times its
original size. Vector image are always
EPSs.

But watch out! There are two big caveats
here:

1) Not all EPSs are vectors

A raster image can be saved as an EPS
from an application such as Photoshop,
but that doesn’t magically make it infi-
nitely scalable. It just means there’s a
PostScript “container” wrapped around a
picture made of dots, and the file name
has “.eps” at the end.

Similarly, a raster image, like a photo, can
be imported into an application such as
Illustrator and ruin the party. If a photo
is placed in Illustrator, a frame is drawn
around it, and the whole thing is then
exported as an EPS, the photo will have
size limitations while the frame will not.

2) EPS files can still have fonts in them

An EPS can contain fonts, and if a print-
er doesn’t have those fonts, the EPS will
not print properly. It’s always a good
idea to convert all fonts to paths (or
“outlines”) to avoid this situation. Just
keep a backup copy before converting
for any future editing of the text.
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Q: Why does this logo suddenly
have a white background?

A: First, make sure the picture box is filled
with “none,” not “white.” If so, it’s most
likely because you didn’t import a vector
EPS (a). TIFFs, JPEGs, etc., may look like
their white backgrounds are “transparent,”
but actually they’re made up of dots —
white dots (b).

If you don’t have a vector version of your
logo but need to put it on a background
color (like green), you have two options.
In Photoshop: 1) fill the logo’s back-
ground with the exact same color green,
or 2) draw what’s called a “clipping
path” around your logo. (This takes
some advanced Photoshop knowledge.)

What if you’ve imported a valid EPS into
QuarkXPress, but it looks horrible?

If a logo or graphic looks “bad” on
screen, don’t panic. It’s likely just the
low-resolution “preview.” The quickest
way to check is to print the page. When
printed, all the PostScript goodness is
sent along, and usually prints fine.

If a jagged preview is just too scary to
look at, QuarkXPress does offer one
little trick. Select the graphic and
control-click (Macintosh) or right-click
(Windows). Then select “Preview
Resolution” and “Full Resolution.”
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Q: What’s all this about
“resolution”?

A: It has nothing to do with New Year’s
Eve. Resolution refers to the sharpness of
an image (or PDF), usually measured in
dots per inch (DPI). The higher the reso-
lution, the greater the image sharpness
and the larger the file size. Resolution
also refers to the image sharpness that
monitors are capable of reproducing. A
typical resolution for printing a photo-
graph on an offset press is 300dpi or ppi
(dots per inch or pixels per inch), while
72dpi is typical for on-screen viewing for
a Macintosh; 96dpi for a PC.

Image resolution is mostly a one-way
street: You can “res down” an image with
an application such as Photoshop (e.g.,
change the dpi from 300 to 72) but you
can’t successfully “res up” to any great
extent. Usually the limit is about 115%–
120% original size before the quality
becomes too poor (blurry) for printing.
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Q: How big is that photo,
really?

A: When it comes to printing and the
proper reproduction of images, size
really does matter. There are two differ-
ent ways to describe the size of a digital
photograph. The first is the traditional
way, by its dimensions. 4" x 5" or 8" x 10"
are typical, just like their real-world
counterparts. The second is by file size,
the amount of disk space the file takes
up. Resolution effects file size because
an 8" x 10" photo at 300dpi is a larger
file size than an 8" x 10" photo at 72dpi.

Thus, when you “reduce” a photo in
Photoshop, you can actually do one of
three things:

1) Keep the resolution the same, but
make the overall dimensions smaller.

You’ll need to use this option if, for
example, you import a photo into a
QuarkXPress picture box, and it’s HUGE.
Don’t set the percentage in QuarkXPress
to 50% or less. It is unnecessary and can
be technically problematic to have a
gigantic photo imported into a picture
box but scaled down to a small percent-
age. Instead, reduce the photo in
Photoshop.

Here’s how to reduce a 300dpi 8" x 10"
photo to, say, 4" x 5", but keep the dpi
300:
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In Photoshop, go to the Image menu
and select Image Size.

Keep the three check-boxes in the bottom
left checked, as shown. Then change
the Width or Height values under
“Document Size” (currently 8" and 10"
in the above example) to 4" x 5". You
actually only need to change one dimen-
sion; the other will change automatically.

2) Keep the overall dimensions the
same, but reduce the resolution.

You’ll need to use this option if you have
a high-res photo or graphic that you
want to use on a website, send via e-mail,
use in a PowerPoint presentation, etc.

In this case, a 300dpi 8" x 10" photo is
reduced to, say, 72dpi, but it remains
8" x 10". Here’s how:
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In Photoshop, go to the Image menu
and select Image Size.

Keep the three check-boxes in the
bottom left checked, as shown. Then
change the Resolution value under
“Document Size” from 300 to 72 (shown
changed to 72 in the above example).
Note that the dimensions (8" x 10")
remain, but the file size has been
reduced from 27.5MB to 1.58MB.

3) Increase the resolution, but make the
overall dimensions smaller.

You’ll need to use this option if you have
a very large but low-res photo you want
to use for offset printing. By increasing
the dpi to 300 but allowing the image to
get smaller in dimensions, you can safely
import it into QuarkXPress and know
that it will print sharply.

In this case, a 72dpi 8" x 10" photo is
converted to 300dpi, but the dimensions
are reduced to 1.92" x 2.4". Here’s how:
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In Photoshop, go to the Image menu
and select Image Size.

Uncheck the Resample Image box in
the bottom left, as shown above. Then
change the Resolution value under
“Document Size” (shown as 72 in the
example above) to 300 (shown in the
example below). Note that the dimen-
sions are reduced to 1.92" x 2.4" in
order to compensate for the increase in
resolution, but the file size (1.58MB)
remains the same.
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Q: What files do I need to
give the printer to make sure
a piece prints correctly?

A: For most jobs, there are three crucial
components: the job file itself (most
commonly a QuarkXPress or InDesign
file); the associated photos and/or
graphics that have been placed on the
pages (almost always TIFFs and EPSs);
and the fonts. If any of these three ele-
ments are missing in part or in total,
trouble is right around the corner.

Luckily, these days both QuarkXPress
and InDesign have built-in commands to
make this task a snap. In QuarkXPress,
go to the File menu and select “Collect
for Output…”. InDesign’s equivalent is
“Package…” also in the File menu.
These commands, as you might suspect,
collect the required files from the three
categories listed above and copy them all
into a folder for easy transfer. They’ll also
warn you if graphics or fonts are missing.
If that happens, it’s up to you to manual-
ly search for those items in order to com-
plete the collection process successfully.

Fonts can be troublemakers.
Occasionally, a printer might not use
your “supplied” fonts, but default to
fonts of the same name they have in their
system. If this happens, you may see
changes in line breaks on the printer’s
proof, so check it carefully.
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Q: What does a printer need
to know to give me an
accurate print estimate?

A: There are five main specifications a
printer requires to accurately estimate a
print job: size, page count, colors, stock,
and quantity.

The “finished” size is the width by height
when the piece is completely closed, “flat”
size when fully opened. A standard 8.5" x
11" finished size brochure has a flat size
of 17" x 11". Always list the width first.

Page count is determined by
counting each side of each page,
including “blanks.” This booklet
would be specified as 8 pages. P

Page counts are always even
numbers and usually multiples
of 4. The only way to add two
pages to a saddle-stitched book
is to add a “flap” page, making
this 10 pages. P

If a different paper stock is used for the
covers, specify “plus cover,” such as
“8 pages plus cover,” totaling 12 pages.

Specify number of colors, such as
4CP/2PMS (four-color process on one
side, two spot colors on the other).

There are thousands of paper stocks
available. Surprisingly, uncoated stocks
are often more expensive than coated.

The cost per piece will decrease as the
quantity increases, so always order extras.
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Conversions

Fraction Decimal
Inches Inches

1/64 .015625

1/32 .03125

1/16 .0625

1/8 .125

3/16 .1875

1/4 .25

5/16 .3125

3/8 .375

7/16 .4375

1/2 .5

9/16 .5625

5/8 .625

11/16 .6875

3/4 .75

13/16 .8125

7/8 .875

15/16 .9375

1 1.0

Bytes, Kilobytes, Megabytes

1,024 Bytes = 1 Kilobyte (KB)

1,024 Kilobytes = 1 Megabyte (MB)

1,024 Megabytes = 1 Gigabyte (GB)

A handy-dandy conversion chart
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Picas/ Millimeters
Points (that’s Metric)

0p1.125 .396

0p2.25 .793

0p4.5 1.587

0p9 3.175

1p1.5 4.762

1p6 6.350

1p10.5 7.937

2p3 9.525

2p7.5 11.112

3p0 12.700

3p4.5 14.287

3p9 15.875

4p1.5 17.462

4p6 19.05

4p10.5 20.637

5p3 22.225

5p7.5 23.812

6p0 25.4

CDs, DVDs, and Photos

A CD holds about 700 MB (716,800 KB).

A DVD holds about 4.7 GB
(4,812.8 MB or 4,928,307.2 KB).

A 4" x 5" four-color photograph at 300dpi
is 6.87 MB. An 8" x 10" four-color photo-
graph at 300dpi is 27.5 MB.



US Paper Sizes

Name Size (inches)
Business Card 31⁄2 x 2
Executive 71⁄2 x 10
A (letter) 81⁄2 x 11
Legal 81⁄2 x 14
B (tabloid) 11 x 17
Super A3/B 13 x 19

Common U.S. Envelope Sizes

Commercial/
Official

Name Size (inches)
61⁄4 31⁄2 x 6
63⁄4 35⁄8 x 61⁄2
7 33⁄4 x 63⁄4
73⁄4 (Monarch) 37⁄8 x 71⁄2
9 37⁄8 x 87⁄8
10 (Business) 41⁄8 x 91⁄2
11 41⁄2 x 103⁄8
12 43⁄4 x 11
14 5 x 111⁄2

A-Style

Name Size (inches)
A-2 43⁄8 x 53⁄4
A-6 43⁄4 x 61⁄2
A-7 51⁄4 x 71⁄4
A-8 51⁄2 x 81⁄8
A-9 53⁄4 x 83⁄4
A-10 6 x 91⁄2
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Metric (European) Sizes

Name Size (inches)
A8 53 x 74 2.07 x 2.91
A7 74 x 105 2.91 x 4.13
A6 105 x 148 4.13 x 5.83
A5 148 x 210 5.83 x 8.27
A4 210 x 297 8.27 x 11.69
A3 297 x 420 11.69 x 16.54

Common U.S. Envelope Sizes

Baronial

Name Size (inches)
4 Bar 35⁄8 x 51⁄8
Gladstone 35⁄8 x 55⁄8
5 Bar 41⁄8 x 55⁄8
51⁄2 Bar 43⁄8 x 53⁄4
6 Bar 43⁄4 x 61⁄2

Square

Name Size (inches)
5 5 x 5

through
131⁄2 131⁄2 x 131⁄2

in half-inch increments

Booklet (horizontal) Catalog (vertical)
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A4 – Metric (European) letterhead
size, 8.25" x 11.75" (210mm x 297mm)
(also see Letterhead size)

AAs – Author’s Alterations – changes
requested by the client after the project
has been sent to the printer

Accordion fold – Two or more
parallel folds in printed paper in which
each fold opens in the opposite direction
from the previous fold (also see Barrel
fold, Gatefold)

Acrobat – Application developed by
Adobe to create and view PDF files (also
see Application, PDF, PDF reader)

Application – Computer program
that accomplishes a specific task, such
as QuarkXPress for desktop publishing,
Adobe Illustrator for drawing artwork,
or Microsoft Word for word processing

Barrel fold – A piece with three or
more panels to a side that continuously
fold from one side only (also see
Accordion fold, Gatefold)
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Binding – The fastening of assembled
sheets along one edge of a publication
(also see Perfect-bind, Saddle-stitch,
Wire-o)

Bitmap – Generically, a type of image
file format that refers to the rows and
columns of dots that make up a digital
photo image; cannot be enlarged with-
out loss of quality (also see BMP, EPS,
File format, GIF, JPEG, Raster,
Resolution, TIFF, Vector)

Bleed – Artwork running off the edge
of a page, or the space allotted for that
artwork, usually 1⁄8'' on all sides (also see
Live area, Trim size)

BMP – Standard bitmapped image
format on Windows-compatible
computers; cannot be enlarged without
loss of quality (also see Bitmap, BMP,
File format, GIF, JPEG, Raster,
Resolution, TIFF, Vector)

Caps – Capital letters, examples:
ALL CAPS OR UPPERCASE
Init (initial) or sentence caps
lowercase
SMALL CAPS

Title Or Bump Caps

CMYK – Printing that uses cyan,
magenta, yellow, and black (CMYK) to
simulate full-color images (also see Four-
color process, Pantone, Spot, RGB)
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Coated stock – Paper with a finish
that produces a smooth, often shinier
surface (also see Stock, Uncoated stock)

Comp (composite) – Layout
simulation to show how a finished piece
will look

Cover stock – Heavier-weight paper
used for the outside of a piece or entire
piece if there is no different inside paper
(also see Self-cover, Stock, Text stock)

Crop mark – Lines around artwork
that indicate the outer edges of the
piece, where it gets trimmed

Cross-platform – Files that can be
used on both PCs and Macs

Crossover – Text or artwork that
spans two facing pages (also see Gutter,
Spread)

Deboss – Impressing an image into
paper to create a recessed surface (also
see Emboss)

Die cut – Custom-made tool, usually
metal, used to stamp out a nonstandard
shape in paper

Digital printing – Method of print-
ing in which the data and images are
printed directly from the computer onto
paper, without using plates (also see
Offset printing, Plate)

DPI – Dots Per Inch, unit of measure
for the resolution of an image (also see
Resolution)
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Draw-down – Thin layer of ink
spread on a paper sample to determine
the color characteristics

Dummy – Set of blank pages assem-
bled to show the size, shape, and weight
of a final printed piece

Duotone – A two-color image created
from a black and white original

Duplex – Paper made up of two
different-colored sheets glued together

Emboss – Impressing an image into
paper to create a raised surface (also see
Deboss)

Engraving – Printing technique
(often used on letterhead, envelopes,
and business cards) that leaves the ink
raised to the touch (also see
Thermography)

EPS – Encapsulated PostScript, file
format that supports both vector
graphics and bitmap images; an EPS
file made from a vector application such
as Illustrator usually can be enlarged
without loss of quality; an EPS made
from Photoshop, or one that includes an
embedded bitmap component, cannot
be enlarged without loss of quality (also
see Bitmap, BMP, File format, GIF, JPEG,
Raster, Resolution, TIFF, Vector)

File format – The way a graphic is
saved; many are available and each has
its own advantages and disadvantages
(also see Bitmap, BMP, EPS, GIF, JPEG,
Raster, Resolution, TIFF, Vector)
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Foil (or hot) stamp – Transferring
a thin layer of metal onto paper using
heat and pressure

Folio – Page number; right-hand page
is always odd

Four-color process (4C) –
Printing that uses cyan, magenta, yellow,
and black (CMYK) to simulate full-color
images (also see Pantone, Spot, RGB)

FPO – For Position Only, a temporary
image that will be replaced by a final
image before printing

Gang printing – Grouping multiple
jobs on the same sheet of paper, often
for cost savings

Gatefold – A piece with four panels
to a side that has foldouts on both sides
of the center panels (also see Accordion
fold, Barrel fold)

GIF – Graphic Interchange Format, a file
compression technique most commonly
used for line art and non-photo graphics
on the web; cannot be enlarged without
loss of quality (also see Bitmap, BMP,
EPS, File format, JPEG, Raster,
Resolution, TIFF, Vector)

Grade – The rating given to paper
based on its brightness, opacity, etc.
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Grain – The direction fibers run in
paper

Gutter – The space between two
adjacent pages, panels, or columns of
text (also see Crossover, Spread)

Hard copy – Black and white or
color printout

Hickeys – Imperfections in a printed
piece; usually caused by dirt on the press
or paper particles

High-resolution – Typically, a
photo that is at least 300dpi, required
for offset or high-quality printing (also
see DPI, Resolution)

Illustrator – Vector drawing applica-
tion from Adobe Systems, Inc. (also see
Application, Vector)

InDesign – Desktop publishing appli-
cation from Adobe Systems, Inc. for
page layout (also see Application)

Indicia – Typically a box with specific
verbiage and permit number used on
mailings as a substitute for stamps

JPEG – Joint Photographic Experts
Group, a file compression technique for
reducing the amount of data needed to
describe a full-color, bitmap image; can
not be enlarged without loss of quality
(also see Bitmap, BMP, EPS, File format,
GIF, Raster, Resolution, TIFF, Vector)

Justify – Setting text so it aligns to
both margins (also see Ragged)
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Kerning – Adjustment of the spacing
between characters in text (also see
Leading)

Knockout – The removal of the back-
ground color on which type or graphics
are being printed (also see Overprint)

Landscape – An image or page that
is horizontally oriented (also see
Portrait)

Leading – (Pronounced “ledding”)
Adjustment of the spacing between lines
in text (also see Kerning)

Letterhead size – 8.5" x 11" (also
see A4)

Live area – Where nonbleed page
elements can be safely located without
the fear of being trimmed off (also see
Bleed, Trim size)

Margins – White space surrounding
the printed area of a page

Metallic ink – Inks containing pow-
dered metal or pigments that simulate
metal

Offset printing – Printing technique
that transfers ink from a plate (typically
a metal sheet) to an intermediate roller,
to paper (also see Digital printing)

Overall varnish – Varnish applied
to an entire side of a printed piece (also
see Spot varnish, Varnish)

Overprint – Printing one color on
top of another color (also see Knockout)
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Overs – Printed pieces delivered in
excess of quantity ordered; typically no
more than 10% is considered acceptable
and billable

Pantone color (PMS) – Pantone
Matching System, a system of inks, color
specifications, and color guides for speci-
fying and reproducing color (also see
Process color)

PDF Reader – A free program
and/or web browser plug-in from Adobe
Systems, Inc. for displaying and printing
(but not manipulating) documents in
Portable Document Format (also see
Acrobat, PDF)

PDF – Portable Document Format, a
format from that enables a document to
be distributed on different systems while
preserving the layout (also see Acrobat)

Perf (perforate) – To create a line
of small dotted holes for the purpose of
tearing off a part of a printed piece

Perfect-bind – A method of binding
in which pages are collated and held
together by adhesive along the spine,
typically for thick books (also see
Binding, Saddle-stitch, Wire-o)

Pica – A typographic unit of measure,
6 to an inch, 12 points (also see Point)
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Plate – A sheet, typically made of
metal, used to transfer ink in the offset
printing process (also see Offset printing)

Platform – The operating system run-
ning software on a computer, in design
and printing usually Macintosh or
Windows

Plus-cover – A book or publication
that uses a different, often heavier-
weight, paper for the cover than for the
interior pages (also see Self-cover)

Point – A typographic unit of measure,
72 to an inch, 12 to a pica (also see
Pica), also a unit of measure that indi-
cates the height of a character of type

Portrait – An image or page that is
vertically oriented (also see Landscape)

PostScript – A “page description”
and programming language from Adobe
Systems, Inc. that is the worldwide stan-
dard in the software industry for design
and printing

Press check (Press OK) –
Quality assurance in which the designer
and/or customer visits the printing plant
as the first few copies of a print job
come off the printing press in order to
check for accurate color, proper registra-
tion, ink coverage, and overall printing
quality

Press proof – A final color proof
made on a printing press to verify color
and printing quality
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Process color – Cyan, magenta,
yellow, and black inks are the four
process colors. Four-color reproduction
of the full range of colors is possible by
combining CMYK inks. When magnified,
tiny dots of these colors will be visible,
but to the naked eye they will merge
(also see Four-color process)

QuarkXPress – Desktop publishing
application from Quark, Inc. for page
layout (also see Application)

Ragged left, right – Setting text so
it aligns flush to one margin only, and is
ragged on the other (also see Justify)

Raster – A bitmapped image made up
of dots, as opposed to a vector image
(also see Bitmap, BMP, EPS, File format,
GIF, JPEG, Resolution, TIFF, Vector)

Resolution – Measured in dots per
inch, the degree of sharpness and clarity
of an image; 300dpi typical for printing,
72dpi typical for on-screen viewing (also
see DPI, High-resolution)

RGB – Red-Green-Blue, used in Web
design and design for monitor viewing,
colors are defined in terms of a combi-
nation of these three colors (also see
CMYK, Four-color process, Process color)

Rights-managed – Photos or
graphic images with which an individual
licensing agreement is negotiated for
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each use (also see Royalty-free, Stock
photography)

Royalty-free – Photos or graphic
images that are sold for a single standard
fee and may be used repeatedly by the
purchaser (also see Rights-managed,
Stock photography)

Rule – A line to be printed, its thick-
ness or “weight” measured in points, the
thinnest being a “hairline,” or 1⁄4 point

Run-around – Text that is set to fit
around the edges of a picture or other
graphic

Saddle-stitch – To bind by stapling
sheets together where they fold at the
spine (also see Binding, Perfect-bind,
Wire-o)

Sans-serif – Fonts that are plain,
without extensions, “feet,” or flourishes
at the ends of strokes, such as Arial and
Helvetica (also see Serif)

E
Scale – To enlarge or reduce a photo
or graphic; scaling is proportionate when
the relative length and width stay con-
stant, disproportionate when they do not.
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Score – To compress paper along a
straight line so it folds more easily and
accurately

Screen printing – Method of
printing where a squeegee is used to
force ink through stenciled fabric,
typically used for printing on clothing,
plastic, and three-dimensional objects
(also see Silkscreen)

Self-cover – A publication’s cover
made from the same paper as the
interior pages of the piece (also see
Plus-cover)

Serif – Fonts that have small exten-
sions, “feet,” or flourishes at the ends of
strokes, such as Times and Garamond
(also see Sans-serif)

E
Sheetfed press – Press that prints
individual sheets of paper (also see Web
press)

Show-through – When printing on
the reverse side of a sheet can be seen
through the sheet under normal lighting
conditions

Silhouette – Typically, removing the
background around an object in
Photoshop, so it looks “cut out”

Silkscreen – See Screen printing

Spot color – A single solid ink color,
usually Pantone, printed using one plate,
as opposed to process color that
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simulates a solid but is actually comprised
of many tiny dots of CMYK inks (also see
Pantone, Plate, Process color, CMYK)

Spot varnish – Varnish applied to
or avoided from a specific area of a
printed piece (also see Overall varnish,
Varnish)

Spread – Two facing pages of a publi-
cation (also see Crossover, Gutter)

Stock photography – Images that
are not photographed for a specific
client or use but are catalogued for
review and selection by someone who
may have a need (also see Royalty-free,
Rights-managed)

Stock – The type of paper or other
material that will be used for printing

Text stock – Lighter-weight paper
used for the inside of a piece or entire
piece if there is no different cover paper
(also see Cover stock, Self-cover, Stock)

Thermography – A process for pro-
ducing raised lettering, as on business
cards, by application of a powder that is
fused by heat to the fresh ink. Sometimes
called “poor man’s engraving” (also see
Engraving)

TIFF – Tagged Image File Format, a
specific kind of bitmapped image that is
used for printing photos and is the most-
widely compatible among applications
and platforms (also see Application,
Bitmap, BMP, EPS, File format, GIF, JPEG,
Platform, Raster, Resolution, Vector)
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Tint – Typically, a percentage of a color,
less than 100%, created by dots rather
than by solid ink coverage

Trapping – Overlapping adjoining
colors or inks; helps minimize the
possibility of a fine white line appearing
between two colors when printed

Trim size – The size of a page after it
has been trimmed (also see Bleed, Live
area)

Uncoated stock – Paper without a
finish; produces a softer, often less shiny
surface (also see Coated stock, Stock)

Varnish – A thin, clear coating
applied to a printed piece for protection
or special effect (also see Overall var-
nish, Spot varnish)

Vector – A file format that does not
use an array of dots to store image infor-
mation but instead stores it as a set of
mathematical properties that describe its
attributes, dimensions, and positions;
can be enlarged without loss of quality
(also see Bitmap, BMP, EPS, File format,
GIF, JPEG, Raster, Resolution, TIFF)
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Vellum – A paper surface that when
magnified has a rough, toothy finish;
translucent vellum paper is also available

Web press – Press that prints from
rolls of paper, rather than sheets;
typically used for very large runs or
lengthy documents such as catalogs and
books (also see Sheetfed press)

Watermark – Translucent logo,
graphic, or text imbedded in paper
during manufacturing

Wire-o – A method of binding in
which a series of wire loops are run
through punched holes or slots along
the inner margins of the pages (also see
Binding, Perfect-bind, Saddle-stitch)
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Got a question
not answered

here? Just ask!

We’ll be happy to assist,
and you might even

win a prize!

Send your question to:

info@cdgi.com
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automatically registered
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featured in our
e-Newsletter (published
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never. But we hope to
publish one soon!).
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